OxCORT
Oxford Colleges On-line Reports for Tutorials

Tutorial Office Role
Version 4.4

BSP Training Team
Business Services and Projects
# Table of Contents

1. Introduction To This manual ........................................................................5  
   Pre-requisites .................................................................................................5  
   Objectives .......................................................................................................5  

2. Introduction To OxCORT .................................................................................7  
   Roles in OxCORT ..........................................................................................7  
   Main menu for Tutorial Office .....................................................................9  
   Overview of Tutorial reports .......................................................................11  
   Overview of Revision Class reports .............................................................12  
   Overview of payments ..................................................................................12  
   Report states ..................................................................................................13  
   Start of year procedures for Tutorial Office ..............................................14  
   Start of term procedures for Tutorial Office ..............................................15  
   End of term procedures for Tutorial Office ..............................................15  
   End Of Year Procedures for Tutorial Office ...............................................15  

3. How To Access OxCORT .................................................................................17  
   To log into OxCORT ......................................................................................18  
     Selecting a role ..........................................................................................18  
     To change the font .....................................................................................19  

4. Configure College Wide Preferences ..........................................................20  
   To configure OxCORT for your College ....................................................20  

5. Change Your Email Address .........................................................................22  
   To change your email address ......................................................................22  

6. Maintain College Bank Details ....................................................................23  
   To enter College bank details ......................................................................23  

7. Enter Or Maintain Teaching Hours Weighting Data .....................................25  
   To enter weighting data for the current year ...............................................25  
   To enter weighting data for the previous or next year ...............................26  

8. Search For People ..........................................................................................27  
   To search for people from the main menu ................................................27  
   To search for people using the Search for People button ..........................27  

9. Authorise Tutors ............................................................................................1  
   To authorise Tutors .....................................................................................1  
   To amend an expiry date or remove a Tutor role .......................................2  

10. Bulk Create User Accounts .........................................................................3  
    To export a list of accounts from OxCORT ...............................................3  
    To view the list of accounts previously exported from OxCORT ..............4
Contents

To edit or create the list of accounts ...........................................4
To import the CSV file ....................................................................5

11. Point Edit User Accounts .......................................................7
    To create or change a single user account ..................................7
    To disable a single user account ..............................................8
    To delete a single user account ..............................................8

12. Bulk Create Student Records ................................................9
    To export the current student records ......................................9
    To view the list of student records previously exported from OxCORT ..................................................9
    To edit or create the list of student records ............................10
    To import the CSV file ..........................................................11

13. Point Edit Student Records ..................................................13
    To create or edit a student record ...........................................13

14. Arrange Tutorials ................................................................15
    To arrange tutorials .............................................................15
    Emailing the Tutor using OxCORT .........................................17
    Emailing the Tutor using your own email client ......................17

15. View Tutorial Arrangements ................................................19
    To view tutorial arrangements ..............................................19

16. View Or Process Tutorial Reports ..........................................21
    To search for reports ................................................................21
    Search fields ..........................................................................22
    To view or edit a report ..........................................................24
    Deleting a report ......................................................................26
    To display reports as a PDF file for printing ............................27
    To send an email using OxCORT ............................................27
    To send an email using your own email client ..........................28
    To export data from reports ...................................................29
    To approve reports for payment .............................................30
    To refuse reports for payment ................................................31
    To delete a refused report ......................................................33
    To release a report to the student ...........................................34
    To return a report to the Tutor for correction ...........................34
    To mark a report as processed for payment ............................35
    To undo a payment decision ..................................................36
    To mark a report with a College flag (red dot) or an academic flag (blue dot) ..................................................37
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.</td>
<td>Manage Stint Data</td>
</tr>
<tr>
<td></td>
<td>To enter core stint data</td>
</tr>
<tr>
<td></td>
<td>To enter stint adjustments</td>
</tr>
<tr>
<td>18.</td>
<td>Validate Tutor Teaching Data</td>
</tr>
<tr>
<td></td>
<td>To view teaching hours</td>
</tr>
<tr>
<td></td>
<td>To view and edit Internal Tuition / Out Tuition reports</td>
</tr>
<tr>
<td></td>
<td>To view a list of External Tuition reports</td>
</tr>
<tr>
<td></td>
<td>To mark the reports as “Processed for Payment”</td>
</tr>
<tr>
<td>19.</td>
<td>Calculate Payments And Teaching Hours</td>
</tr>
<tr>
<td></td>
<td>To enter non-standard payment amounts</td>
</tr>
<tr>
<td></td>
<td>To preview payments details</td>
</tr>
<tr>
<td></td>
<td>To calculate payments and teaching hours</td>
</tr>
<tr>
<td>20.</td>
<td>Manage Tutor Payment Data</td>
</tr>
<tr>
<td></td>
<td>To include reports which have a status of Approved</td>
</tr>
<tr>
<td></td>
<td>To include reports which have a status of Processed</td>
</tr>
<tr>
<td></td>
<td>To export a payment file</td>
</tr>
<tr>
<td>21.</td>
<td>Reports</td>
</tr>
<tr>
<td></td>
<td>To view payment related operational reports</td>
</tr>
<tr>
<td></td>
<td>To view stint related operational reports</td>
</tr>
<tr>
<td>22.</td>
<td>List Payments Due From Other Colleges</td>
</tr>
<tr>
<td></td>
<td>To view payments due from other Colleges on screen</td>
</tr>
<tr>
<td></td>
<td>To export payments due from other Colleges</td>
</tr>
<tr>
<td>23.</td>
<td>View Tutorial Hours By Organising Tutor</td>
</tr>
<tr>
<td></td>
<td>To view tutorial hours by Organising Tutor</td>
</tr>
<tr>
<td></td>
<td>To view tutorial hours for a previous academic year</td>
</tr>
<tr>
<td>24.</td>
<td>View Management Information</td>
</tr>
<tr>
<td></td>
<td>To view statistical information</td>
</tr>
<tr>
<td></td>
<td>To view the Benchmark report</td>
</tr>
<tr>
<td>25.</td>
<td>Log Out Of OxCORT</td>
</tr>
<tr>
<td></td>
<td>To log out of OxCORT</td>
</tr>
<tr>
<td>26.</td>
<td>Data Protection Act</td>
</tr>
<tr>
<td>27.</td>
<td>Document Information</td>
</tr>
<tr>
<td>28.</td>
<td>Further Help &amp; Information</td>
</tr>
</tbody>
</table>
1. Introduction To This manual

This manual is aimed at the Tutorial Office role within OxCORT and covers all the functionality available within that role.

OxCORT is a system that allows Tutorial and Revision Class reports to be created, written, read and processed for payment.

Some of the functionality in OxCORT is available to more than one role. This is to allow you to reflect your own College’s processes when using the system, for example, reports may be approved by the Organising Tutor, Senior Tutor or the Tutorial Office role. When a function is available to other roles, it will be indicated in the introduction to the section.

Screens shown in this manual are taken from the OxCORT Training database which contains fictional Colleges, Users and Students.

The section headings of this manual are the same as the main menu options shown for your role.

Please read the sections starting on page 14 for information about which time of year each activity should be undertaken.

Pre-requisites

This manual assumes a basic knowledge of using a computer, keyboard and mouse and basic web browser knowledge.

Objectives

This manual is designed primarily as a reference guide to allow the user with a Tutorial Office role in OxCORT to use all the available functionality.

| ![Icon] | Indicates additional useful information. |
| ![Icon] | Indicates an important piece of information, take particular care to read the information in these boxes. |
| **Bold Text** | Indicates menu names and window titles. |
| **[F4]** | Keys on your keyboard are indicated in bold text enclosed in square brackets [ ]. |
| **File > Open** | Moves through a navigation path are indicated with a >. In this case you would click on the File menu, then select Open |
2. Introduction To OxCORT

OxCORT (Oxford Colleges On-line Reports for Tutorials) is a system that allows Tutorial and Revision Class reports for undergraduate (also M Jur and BCL) students to be created, written, read and processed for payment.

The system is designed to be flexible to allow Colleges to follow their preferred processes as closely as possible, for example a College may choose whether or not to allow someone with the Organising Tutor role to approve a report for payment. Some functions are available to several roles, again allowing flexibility, for example Tutorial Office, Senior Tutors and Organising Tutors may all arrange tutorials allowing each College to decide which role is the most appropriate to perform this function.

Roles in OxCORT

OxCORT is designed to reflect the fact that many people in the University have several roles. There are seven roles that can be assigned in OxCORT and you may be assigned more than one role in OxCORT to reflect your roles within the University. Users with several roles will be asked to select one upon logging into OxCORT. Roles may be switched at any time by selecting from the main menu.

The roles in OxCORT are as follows:

OxCORT Management Committee role
The OxCORT Management Committee (OMC) role is available to those Senior Tutors who have been nominated by the Senior Tutors Committee to manage the OxCORT project.

This role allows the user to upload the Register of Payments. The OMC are also responsible for assigning others the Course Director role in OxCORT and authorising the Pay My Department payment method. The OMC role also allows the user to create reports on OxCORT usage.

Course Director role
The Course Director role in OxCORT is available to those in Departments who have responsibility for organising teaching on behalf of Colleges.
This role allows the user to arrange tutorials for students who are studying a Programme of Study that matches those assigned to the Course Director. Course Directors may also assign the Tutor role to others in OxCORT.

A Course Director may view a report only if the relevant College has allowed it. The College may allow a Course Director two levels of access to a report. Level one allows them to see the report header only, level two allows them to see the whole report (provided the OMC has allowed this when creating the role).

**Tutor role**
The Tutor role is not College specific, therefore a user only needs to be assigned this role once.

The Tutor role allows the user to write and submit for payment Tutorial and Revision Class reports on any student in any College.

Through OxCORT, the Tutor can also maintain their payment details and view payment claims.

**Student role**
The student role is automatically assigned to any current undergraduate M Jur or BCL student in the university.

A student may view the heading of a report written about them as soon as it is created and may view the full report once it has been released to them by an appropriate role within their College.

**College roles**
These roles are College specific. If you require these roles at more than one College, each College Tutorial Office user will need to assign you the relevant role at their College.

**Tutorial Office role**
Within their own College, this role allows the user to perform all the functions available to all other ‘College’ roles. They may also perform extra administrative functions, run statistical reports, and administer payments within OxCORT.

The Tutorial Office role is able to assign all College roles within their own College.

**Senior Tutor role**
Within their own College, this role allows the user to arrange tutorials, view and approve (for payment) Tutorial and Revision Class reports and run statistical reports.

The Senior Tutor role is able to assign the Tutor role to others.

**Organising or Personal Tutor role**
*The Organising or Personal Tutor role is often referred to simply as the Organising Tutor role.*

The organising tutor role will be given to all those who might organise tutorials for a student in college and would need to see the reports for that student. The personal tutor role allows for filtering of reports for end-of-term report reading for those with that personal tutoring responsibility for specific students (which are likely to be a smaller group than those for whom a Tutor might be an organising tutor).
Within their own College, this role allows the user to arrange tutorials and view and approve (for payment) Tutorial and Revision Class reports on students assigned to them by the Tutorial Office.

The Organising Tutor role may assign the Tutor role to others.

Main menu for Tutorial Office

Report counts

Across the top of the menu screen you will see report counts. These show the total number of reports (that are relevant to you) in each state (see below for further information on report states). Clicking on the number shown will retrieve all reports that match that state.

View or process Tutorial reports

This menu option will take you to the Report Search and Select screen and allow you to search for, view, edit and perform various tasks against both Tutorial and Revision Class reports.

View tutorial arrangements

A report style screen which shows the Organising and Personal Tutors assigned to each student. Any reports created for a student (but not yet processed for payment) will also be listed here.

Arrange tutorials

This screen will allow you to make tutorial arrangements with another tutor for your own students and create a blank Tutorial report for the Tutor to complete on OxCORT.

View tutorial hours by Organising Tutor

Listed in order of Organising Tutor, this report shows the number of hours recorded on Tutorial and Revision Class reports for each student.
Authorise Tutors
This menu option allows you to give a Tutor access to the OxCORT system.

Search for people
This menu option allows you to search for people and view information about them (for example to look up their user name).

Bulk create user accounts
This allows you to upload a file which creates user accounts for Tutorial Office, Senior Tutor and Organising Tutors in your College, allowing them access to the OxCORT system.

Point edit user accounts
This allows you to create, edit or remove user accounts for Tutorial Office, Senior Tutor and Organising Tutors in your College one person at a time.

Bulk create student records
This allows you to upload a file which links students to Personal Tutors and Organising Tutors in your College.

Point edit student records
This allows you to edit the student records (which links students to Personal Tutors and Organising Tutors) one student at a time.

Manage Tutor payment data
This allows you to export a file containing payment information.

List payments due from other Colleges
Produces a report detailing payments owed to you by other Colleges for exchange teaching.

View management information
Allows you to generate statistics on data stored in OxCORT.

Enter or maintain teaching hours weighting data
If your College is using a different weighting scale to that used in the Register of Payments, you can use this screen to enter the College weighting data.

Configure College wide preferences
This screen allows you to configure OxCORT to match your College’s preferences.

Manage stint data
This screen allows you to enter core stint hours and adjustments for Tutors at your College.

Calculate payments and teaching hours
This screen allows you to enter non-standard payment amounts, calculate the payments and hours due to Tutors, departments and other Colleges. Once run it will change the status of all reports from Processed to Completed.

Validate Tutor teaching data
This screen allows you to check the payment information entered onto reports, correct any errors and bulk mark reports as Processed.

**Change your email address**

This screen allows you to change the default email address for your account in OxCORT.

**Maintain College bank details**

This screen allows you to enter and keep up-to-date the bank details for your College.

**Reports**

This screen allows you to view and print payment and stint reports.

**Change role**

This option allows you to switch to a different role in OxCORT.

**Overview of Tutorial reports**
Overview of Revision Class reports

Overview of payments

At the start of each academic year:

- OxCORT Management Committee: Enter or Maintain Register of Payments Data
- Tutor: Change Payment Details
- Tutorial Office: Enter or Maintain Teaching Hours Weighting Data
- Tutorial Office: Manage Stunt Data
- Tutorial Office: Maintain College Bank Details

Each term:

- Tutorial Office: Validate Tutor Teaching Data
- Tutorial Office: Calculate Payments and Teaching Hours
- Tutorial Office: Manage Tutor Payment Data
- Tutorial Office: List Payments Due From Other Colleges
- Tutorial Office: Reports
- Accounts / Payroll: Pays all money owing to Tutors, Colleges and Departments

Tutor and Revision Class reports are created, edited, submitted and approved.
Report states

Report is created using the Arrange Tutorials function

Report Status is Not Edited

Report is edited by the Tutor

Report is Created by the Tutor

Report Status is Created

Report is sent back to the Tutor for amendment

Report is completed and Submitted by the Tutor

Report Status is Submitted

Can the report be returned to the Tutor for amendment?

Yes

Can the report be corrected by the Tutorial Office?

Yes

Report status is updated by Organising Tutor, Senior Tutor or Tutorial Office to Approved

Decision undone

Payment decision is undone or payment details are manually corrected

No

Report is checked. Can the report be approved?

Yes

Report is verified. Are the payment details correct?

Yes

Report Status is Approved

Payment corrected

Report is updated by Organising Tutor, Senior Tutor or Tutorial Office to Reduced

No

Report status is updated by Tutorial Office to Processed

Tutorial Office calculate payments and input them in order to produce an export file for accounts.

Report Status is Completed
Reports can be in various ‘states’. These states reflect the stage at which the report has reached. These states are reflected in the Report Count shown above the main menu. The seven possible states are:

- **Not Edited**: Reports that have been created (by Tutorial Office, Senior Tutor, Organising Tutor or Course Director), but have not yet been edited by the Tutor. These reports can be deleted by Tutorial Office users, Senior Tutors, Organising Tutors or Course Directors as well as the Tutor.

- **Created**: Reports that have either been created or edited by the Tutor. These reports can be deleted by the Tutor or Tutorial Office roles.

- **Submitted**: Reports that have been submitted by the Tutor for payment. These reports can have the payment information edited by the Tutorial Office user, if necessary, but cannot be deleted by any role.

- **Approved**: Reports that have been approved for payment (reports in this state cannot be edited or deleted by any role).

- **Refused**: Reports that have been refused for payment.

- **Processed**: Reports that have been processed for payment by the Tutorial Office role (reports in this state cannot be edited or deleted by any role).

- **Completed**: Reports where payment data has been generated by the Tutorial Office role (reports in this state cannot be edited or deleted by any role).

**Start of year procedures for Tutorial Office**

These actions can be taken just before the start of Michaelmas Term.

- **Authorise Tutors** – ensure all the Tutors have access to OxCORT using this screen.

- **Bulk Create User Accounts** – ensure all other College users at your College have access to the OxCORT system using this screen.

- **Bulk Create Student Records** – ensure students have been matched to their Personal and Organising Tutors using this screen.

- **Configure College Wide Preferences** – ensure OxCORT is set-up to best reflect the procedures practiced in your College.

- **Change Your Email Address** – ensure that OxCORT holds the correct email address for you.

- **Enter or Maintain Teaching Hours Weighting Data** – check that the weighting data set up for this year, matches that which is used by your College.

- **Maintain College Bank Details** – Ensure that the College bank details are correct and up-to-date.
Manage Stint Data – Enter the core stint data for Tutors at your College. N.B Tutors will need to have recorded that they have an appointment at your College in their “Change Payment Details” screen.

Start of term procedures for Tutorial Office

Arrange Tutorials – If this is not carried out by a different role in your College, use this screen to record which Tutorials will be happening this term.  
Point Edit User Accounts / Authorise Tutors – If any new members of staff have joined your College you will need to authorise them to use OxCORT.  
Point Edit Student Records – If any students have been assigned a different Organising or Personal Tutor you will need to amend the student record here.

End of term procedures for Tutorial Office

View or Process Tutorial Reports – View and edit Tutorial and Revision Class reports, and if necessary, approve them or return them to the Tutor. Release the reports to the students from this screen also (if your College allows this).  
View Tutorial Arrangements – Use this screen to check that reports have been submitted.  
Manage Stint data – if necessary, enter any adjustments to Tutor’s stint.  
Validate Tutor Teaching Data – Use this screen to check that payment information has been correctly entered and mark the reports as Processed.  
Calculate Payments and Teaching Hours – Use this screen to calculate payments due, the report status will change from Processed to Completed.  
Manage Tutor Payment Data – Use this screen to export a .csv file for your accounts department.  
Reports – Use this screen to view and print payment and stint reports including pay slips.

End Of Year Procedures for Tutorial Office

View Tutorial Arrangements – Use this screen to check that all reports have been submitted and email Tutors to remind them to submit the reports if necessary. You can also delete reports if necessary. Finalists will no longer be active on OxCORT so any reports not yet created will have to be done on paper, also be aware that Finalists will no longer be able to log into OxCORT to see their reports online.  
Students are finalized a few weeks after the end of TT. You can check if this has happened through the OSS data views: 

1. Select the data view labelled “Year outcome/final awards”.  
2. Search for your students (you can search by College, POS or student name)
3. If the "Date of award" column shows a date, this will be the Completion date and show that the student has been finalised.

4. If you want to see further detail, click on a student name to see the full details for that student. The "Programme Attempt Status" will show as Complete if they have been finalised.

This should then be transferred to OxCORT via the datafeed that runs between OSS and OxCORT.

Remove student records for finalists by one of the following two methods, once this has been done these students will no longer be active on OxCORT (this will not delete any reports):

**Point Edit Student Records** – Enter the username for each finalist student and click the **Show** button. Delete the usernames of all Organising and Personal Tutors and save the record.

**Bulk Create Student Records** – Export the data from OxCORT via this screen and delete all columns except the first two and save the file with a new name. Import this new file. This will remove the Organising and Personal Tutors for ALL STUDENTS, however you can use the original export file as a basis to create the new file for import at the start of the new academic year.
3. How To Access OxCORT

OxCORT can be accessed from any computer, anywhere in the world.

In order to access OxCORT you will need to have been issued with a WebAuth account (this is the Oxford University Single Sign-On system, for further information see: http://www.oucs.ox.ac.uk/webauth/). Your Webauth username will take the form of four characters followed by four numbers e.g. ‘abcd1234’.

If you have not been issued a WebAuth username and password you will need to contact OUCS (Oxford University Computing Service), for further information about this visit http://www.ict.ox.ac.uk/oxford/username/.

You will also need to have been set up with at least one role in OxCORT, this should be done by another Tutorial Office user in your College. If there is no other Tutorial Office user to do this then you will need to email support on oxcort@admin.ox.ac.uk.

⚠️ After 1 hour of inactivity, you will be automatically logged out of OxCORT. When using a public or shared computer it is important that you log out of the system correctly, see the section headed
To log into OxCORT

1. Open your web browser (internet explorer, firefox or similar).
2. Enter the address www.oxcort.ox.ac.uk.
3. You will be see the OxCORT website. The OxCORT website is used to inform you of important news and information relating to OxCORT.
4. Click the button to enter the OxCORT live system.
5. Unless you are already signed in to the Single Sign On system, you will be taken to the University of Oxford Single Sign On screen.
6. Enter your WebAuth username and password and click the button.
7. You will be shown the University of Oxford Single Sign-On Confirmation screen. Click the button.

Selecting a role

Once you have accessed OxCORT you will be taken to the Welcome screen. As a Tutorial Office user, you will automatically receive the roles of Tutorial Office and Organising or Personal Tutor.
1. You will be asked to select a role.
2. Click the link, **Tutorial Office at [your college]**.
3. You will be taken to the main menu for the Tutorial Office role.
For further information see page 9.

**To change the font**

OxCORT will display in the browser’s default font.

To change this you will need to go into the **Options** (usually on the browser’s **Tools** menu) and change the font.

Internet Explorer has a **Fonts** button on the **General** tab.
Firefox has a font option on the **Content** tab.
4. Configure College Wide Preferences

The **Configure College Wide Preferences** screen allows you to control how OxCORT behaves within your College. These options are:

**Releasing Reports to Students**
- Senior Tutors, Organising Tutors or Personal Tutors choose when students can see reports
- If you would like the Senior Tutors, Organising Tutors and Personal Tutors to be able to release reports to students, tick this field. If left unticked the reports will be automatically released upon submission by the tutor.

**Approving Reports**
- Organising Tutors may approve and refuse a report and its hours
- If your College processes allows for Organising Tutors to approve the hours entered on a report for payment, tick this field. If left unticked only Senior Tutors and Tutorial Office roles will be able to approve or refuse a report.

**Course Director Access to Report Summaries**
- The OMC may authorise Course Directors to see report summary information
- When the Course Director role is created by the OMC, they can allow the Course Director access to the information displayed in the heading of a report. If your College would like anyone with the Course Director role to see this, tick this field. If you do not wish to allow Course Directors to access any information on a report, untick this field.

**Course Director Access to Full Report Text**
- The OMC may authorise Course Directors to see the full text of report
- When the Course Director role is created by the OMC, they can allow the Course Director access to the full text of a report (including ratings and attendance). If your College would like anyone with the Course Director role to see this, tick this field. If you do not wish to allow Course Directors to access full information on a report, untick this field.

Only the Tutorial Office role can Configure College Wide Preferences in OxCORT.

*If the Pay My Department Payment Method has been used, the Course Director will be able to see the payment information on a report (not the academic information) regardless of the settings in this screen.*

**To configure OxCORT for your College**

1. Select **Configure college-wide preferences** from the main menu.

2. The **Configuration of College Wide Preferences** screen will be displayed.

3. Tick or untick the options to best suit your College.
4. Click the **Save Changes** button.

5. The **Change College Wide Preferences Confirmation** screen will be displayed.

6. Check the information shown is correct and click the **Yes** button.

7. You will be returned to the main menu.
5. Change Your Email Address

This functionality allows you change your email address. The email address you enter in here will be used to contact you about OxCORT. It will also be the email address displayed as the sender of any email you send using the OxCORT email facility.

⚠️ Leaving the email address field blank on this screen will cause errors to occur when you are using OxCORT.

To change your email address
1. Select [Change your email address] from the main menu.
2. The Change Email Address screen will display.
3. Delete the email address showing currently and enter your preferred email address.
4. Click the [Save] button.
5. You will be returned to the main menu.
6. Maintain College Bank Details

This screen allows you to enter and maintain the bank details for your College into which payments due to your College by other Colleges will be paid.

⚠️ Ensure the information in this screen is kept correct and up to date as this will be the information that other Colleges will use to make payments to your College.

💡 All details entered into OxCORT are protected over the network using high-grade encryption.

To enter College bank details

1. Click the Maintain College Bank Details link on the main menu.
2. The Maintain College Bank Details screen will be displayed.
   ![Maintain College Bank Details Screen]

3. Enter the College bank details as follows:
   - **Account Name**: Enter the name as it is shown on the bank statement.
   - **Account Number**: Enter the number of the bank account.
   - **Sort Code**: Enter the sort code, this must include the – symbol. For example 12-34-56.

🔍 The bank sort code will consist of a six-digit number often separated by two dashes into three groups of two figures. The bank account number will consist of up to 8 numbers. Both of these will appear on a cheque book or recent bank statement.

🔍 **Building Society Reference**: If applicable, enter the Building Society reference or Roll Number. Only complete this if the College holds their account with a Building Society. This will normally be found on a recent statement. Check with the Building Society if unsure.
Maintain College Bank Details

**Bank Name:** Enter the full name of the bank here.

**Branch Name:** Enter the full branch name of the bank here, this will normally be shown on a bank statement.

**Branch Address:** Enter the address of the branch of the bank here.

**Cheques payable to:** Some Colleges pay by cheque enter the College name as it appears on the bank statement here.

You must complete every field except the Building Society Number field before attempting to save.

4. Click the **Save** button.

5. The confirmation screen will display.

6. Check the details carefully and click the **YES – Save data** button.

7. You will be returned to the main menu.
7. Enter Or Maintain Teaching Hours Weighting Data

This screen allows you to enter and maintain the weighting factors which apply to Undergraduate Tutorial Teaching by Tutorial fellows at your College. These weighting factors will have been determined locally by your College and allow you to set OxCORT to take into account the size of the group when calculating a Tutor’s stint (direct payments will be calculated using the Register of Payments).

By default OxCORT will apply the weighting factors from the Register of Payments to all teaching unless you amend the rates in this screen.

Changes you make will only be applied to reports which have not yet reached the status of **Processed**.

**To enter weighting data for the current year**

1. Click the [Enter or maintain Teaching Hours Weighting data](#) link on the main menu.
2. The **Teaching Hours Weighting** screen will be displayed.

3. The weighting factors for the current year will be displayed, if you have not yet entered any weighting factors for your College, the figures shown will be those entered into OxCORT by someone with the OxCORT Management Committee role from the information contained in the Register of Payments.

The weighting factors for the Standard rate will be shown in the left column and the Higher rate will show in the column on the right. ULNTF weighting factors will not be displayed because these Tutors do not have a College stint.
Enter Or Maintain Teaching Hours Weighting Data

4. For each weighting factor that you wish to amend, click inside the relevant field and delete the current data, then enter your own.

5. Once each field has had the figures amended to match those agreed by your College, click the Save button.

6. The confirmation screen will be displayed.

   ![Save data](image)

   *About to amend new Teaching Hours Weighting Factors for North for 2008/2009. The weighting factors that you have entered will apply to all OxCORT reports in respect of teaching delivered by Tutors who have a stint at North during the academic year 2008/2009 which have not already been processed for payment. The weighting factors which were applied to any reports created during 2008/2009 which have already been processed for payment will not be changed. Do you wish to proceed?*

   YES - Save data

   NO - do NOT save data

7. Click the YES - Save data button.

8. You will be returned to the main menu.

   ![](image) Changes you make will only be applied to reports for the current year which have not yet reached the status of Processed.

To enter weighting data for the previous or next year

1. Click the Enter or maintain Teaching Hours Weighting data link on the main menu.

2. The Teaching Hours Weighting screen will be displayed with the current year’s data.

3. Click the Next button at the bottom of the screen.

4. Select the year you wish to edit from the Select Year drop down.

5. Click the Previous button.

6. The data for the select year will be displayed.

7. Follow steps 4 through to 8 in the To enter weighting data for the current year section above.

   ![](image) Changes you make will only be applied to reports for the selected year which have not yet reached the status of Processed.
8. Search For People

This screen allows you to search for and view information about students and staff. For example, this screen can be useful when looking for the username of person.

This screen can be accessed both from the main menu and via a button on any screen where you need to enter a person’s username.

To search for people from the main menu

1. Click the **Search for people** link on the main menu.
2. You will be taken to the **Search for People** screen.
3. Complete the search fields as required.
   
   **Important:** Your search must include either a Programme of Study or at least part of the name.

4. Click the **Search** button.
5. The search results will display.
6. If your search has produced more than 20 matches only the first 20 will be displayed. To display the next 20, click the **Next page** button.

To search for people using the Search for People button

1. Click the **Search for people** button.
2. Follow steps 2 through to 6 in the **To Search for People From the Main Menu** section above.
3. To select a person, click the **use** button to the left of their name.
9. Authorise Tutors

In order to access OxCORT, Tutors need to be authorised to use the Tutor role within OxCORT. The process of authorising a Tutor will set a default expiry date of one year from the date of authorisation. However, the expiry date can be manually changed at any time during the year. The Tutor role may also be removed at any time.

Tutors will receive an automated email 7 days before their Tutor role is due to expire advising them to contact their Tutorial Office if they require an extension to the role.

In order to access OxCORT, Tutors will require a WebAuth account. Members of Oxford University staff should receive this automatically upon commencement of their position. External Tutors will require a ‘Virtual Card’ (a WebAuth account for non-staff members). See the Further Help & Information section on page 71 for detail of how to apply for a virtual card.

The Tutor role is not College specific, therefore a Tutor who is writing reports for more than one College only needs to be authorised once by one College to be allowed to write reports for all relevant Colleges.

The following roles can authorise Tutors to use OxCORT:
- Tutorial Office
- Senior Tutors
- Organising Tutors
- Course Directors

To authorise Tutors

1. Select Authorise Tutors from the main menu.
2. You will be taken to the Authorise Tutor page.
3. Enter the Username of the Tutor.
4. Click the Show button.

If you do not know the username of the Tutor, click the Search for people button and follow the instructions in the Search For People section on page 27.

5. The full name of the Tutor will display. If they have previously been authorised a reminder of the expiry date will also be displayed.
6. To authorise (or re-authorise) a Tutor, click the **Authorise** button.
7. A confirmation screen will be displayed for a few seconds before you are taken back to the Authorise Tutor screen.

**To amend an expiry date or remove a Tutor role**

1. Select **Authorise Tutors** from the main menu.
2. You will be taken to the Authorise Tutor page.
3. Enter the Username of the Tutor.
4. Click the **Show** button.

   **If you do not know the username of the Tutor, click the **Search for people** button and follow the instructions in the Search For People section on page 27.**

5. The full name of the Tutor will display. If they have previously been authorised a reminder of the expiry date will also be displayed.
6. Enter a new expiry date into the Expiry date field and click the **Authorise** button.

   **If the Tutor role is to be removed, enter a past date into the Expiry date field before clicking on Authorise.**

   A confirmation screen will be displayed for a few seconds before you are taken back to the Authorise Tutor screen.
10. **Bulk Create User Accounts**

In order to access OxCORT other College users need to be authorised to use OxCORT. The **Bulk Create User Accounts** screen will allow you to create, enable, disable and modify user accounts for your College by importing a CSV (comma delimited) file containing account information for all the users in your College.

*These instructions are for creating/editing the CSV file using Microsoft Excel. You could however use Notepad to edit the file if preferred.*

The Bulk Create User Accounts functionality should be used at the start of each academic year to ensure all the appropriate staff have access to use OxCORT. It is therefore suggested that you start by exporting the account information from the previous year and amending the data appropriately before importing the amended data for the new academic year.

The College roles are College specific, therefore an Organising Tutor who is associated with more than one College needs to be authorised by each College.

Only the Tutorial Office role can Bulk Create User Accounts in OxCORT. This functionality will allow you to create the following roles:

- Tutorial Office (upon authorisation at this level the user will also be given the roles of Organising Tutor)
- Senior Tutor (upon authorisation at this level the user will also be given the roles of Organising Tutor and Tutor)
- Organising Tutor (upon authorisation at this level the user will also be given the role of Tutor)

If you only wish to add or change the accounts for one or two users, refer to the Point Edit User Accounts section of this guide. See section 11 **Point Edit User Accounts** on page 7.

**To export a list of accounts from OxCORT**

1. Select [Bulk create user accounts] from the main menu.
2. The **Bulk User Account Creation** screen will be displayed.
3. Click the [Export current data] button.
4. You will be given the option to save or open the file. Select the option to **Save** and store the file in an appropriate location with an appropriate name, for example “Exported User Accounts for Academic Year 0809”
To view the list of accounts previously exported from OxCORT

1. Open Microsoft Excel.
2. Select File>Open and browse the file you have saved from the export.
3. You may see a Date Watch dialog box. If you do click the OK button.
4. The spreadsheet will open listing all the user accounts currently set up in OxCORT.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>uno001 TO</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno002 ST</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno003 ST</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno004 ST</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno005 ST</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno100 TO</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno101 TO</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno200 ST</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno201 ST</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno202 ST</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno203 ST</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno300 TO</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno301 TO</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno400 TO</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno401 TO</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno500 TO</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uno600 TO</td>
<td>R</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Column A will contain all the usernames for the current user accounts.
Column B will contain the highest role level assigned to that user.
Column C will contain either a letter E to show the account is enabled or the letter D to show that the account is Disabled.

5. Before you start to edit the information it is advisable to save the spreadsheet under a new file name so that you will still have a copy of the export which is unchanged. To do this select File>Save As ensure the file type is set to CSV (comma delimited) and enter a new name for the file, for example "User Accounts for Academic Year 0910 for Import".

To edit or create the list of accounts

1. If you are creating the list for the first time open Microsoft Excel and work in a new worksheet. If you are editing the exported file follow the instructions above.
2. Ensure Column A contains the usernames for every member of staff in your College who needs to have an account on OxCORT.

⚠️ This list MUST INCLUDE YOURSELF. Otherwise your account will be disabled with immediate effect.

3. In column B (against each username) enter the two character code for the highest applicable role required by the individual. These two character codes are as follows:

   TO = This code will assign the user Tutorial Office role (this will also give them the role of Organising Tutor).
   ST = This code will assign the user Senior Tutor role (this will also give them the roles of Organising Tutor and Tutor).
   OPT = This code will assign the user Organising or Personal Tutor role (this will also give them the role of Tutor).
4. In column C you need to show whether the account is active or not. To do this:
   - Enter the letter **E** to enable the account for login.
   - Enter the letter **D** to disable the account. You must either do this or remove the username from the file if a member of staff on the list no longer works at your College. The user will no longer be able to log into OxCORT.

5. Select **File>Save As**, ensure the file type is set to CSV (comma delimited) and enter a new name for the file (if necessary).

   **Warning:** If you do not include a current OxCORT user in this file their account will automatically be disabled.

**To import the CSV file**

1. If necessary, select **Bulk create user accounts** from the main menu.
2. The **Bulk User Account Creation** screen will be displayed.
3. Click the **Browse** button.
4. The **File Upload** dialog box will open. Navigate to the file you have created and click once to select it, then click the **Open** button.
5. In OxCORT, click the **Import** button.
6. You will be taken to the **Bulk Account Creation** screen.
7. Click the **Yes-Replace all account information** button.
8. The data will load and a bar will show it’s progress. When the upload has successfully completed you will be returned to the main menu.
11. **Point Edit User Accounts**

In order to access OxCORT other College users need to be authorised to use OxCORT. The **Point Edit User Accounts** screen allows you to create, enable, disable or modify a user account one person at a time.

The College roles are College specific, therefore an Organising Tutor who is associated with more than one College needs to be authorised by each College.

Only the Tutorial Office role can Point Edit User Accounts in OxCORT. This functionality will allow you to create the following roles:

- **Tutorial Office** (upon authorisation at this level the user will also be given the role of Organising Tutor)
- **Senior Tutor** (upon authorisation at this level the user will also be given the roles of Organising Tutor and Tutor)
- **Organising Tutor** (upon authorisation at this level the user will also be given the role of Tutor)

The Point Edit User Accounts facility allows you to add or edit a user account one person at a time. Therefore if you need to add or edit a number of accounts you may prefer to use the **Bulk Create User Accounts** menu option which will allow you to create, enable, disable and modify user accounts for your College by importing a CSV (comma delimited). See **Bulk Create User Accounts** on page 3 for further information.

To create or change a single user account

1. Select **Point edit user accounts** from the main menu.
2. You will be take to the **User Account Creation and Editing** screen.
3. Enter the username of the person and click the **Show** button.
   
   If you do not know the username of the person, click the **Search for people** button and follow the instructions on page 27.

4. Select the appropriate OxCORT role from the Role dropdown list from the following options:

   - **Tutorial Office Staff** = This option will assign the user Tutorial Office role (this will also give them the roles of Organising Tutor and Tutor).
   - **Senior Tutor** = This code will assign the user Senior Tutor role (this will also give them the roles of Organising Tutor and Tutor).
Organising or Personal Tutor = This code will assign the user Organising or Personal Tutor (this will also give them the role of Tutor).

5. Ensure the [Account is enabled for logon] is ticked otherwise the user account will not be active.

6. Click the [Save Changes] button.

7. The confirmation screen will display the details of the person and the selected role, check these are correct and click [Yes-Save Changes].

To disable a single user account

This option is used when a user no longer requires access to OxCORT, for example, someone who is no longer a member of staff at your College.

1. Select [Point edit user accounts] from the main menu.

2. You will be taken to the User Account Creation and Editing screen.

3. Enter the username of the person and click the [Show] button.

4. Untick the [Account is enabled for logon] field by clicking on it.

5. Click the [Save Changes] button.

6. The confirmation screen will display the details of the person, the selected role and a message reading The account should be disabled, check these are correct and click [Yes-Save Changes].

To delete a single user account

This should only be done if the account was created in error. Any persons no longer requiring a role should be disabled (see above) and not deleted.

1. Select [Point edit user accounts] from the main menu.

2. You will be taken to the User Account Creation and Editing screen.

3. Enter the username of the person and click the [Show] button.

4. In the field at the bottom of the screen type the words THIS ACCOUNT WAS CREATED IN ERROR.

5. Click the [Delete] button.

6. You will be returned to the User Account Creation and Editing screen.

Only use the delete function if the account was created in error, it should not be used for removing members of staff who are no longer associated with your College. If you delete an Organising Tutor, Senior Tutor, or Tutorial Office account, any reports associated with that user (either through a payment decision or a comment) will be permanently deleted.
12. Bulk Create Student Records

The Bulk Create Student Records function allows you to link students to their Organising and Personal Tutors. This process allows you to import a csv file containing the information into OxCORT.

These instructions are for creating/editing the CSV file using Microsoft Excel. You could however use Notepad to edit the file if preferred.

Only the Tutorial Office role can Bulk Create Student Records in OxCORT.

⚠️ The Bulk Create Student Records functionality should be used at the start of each academic year to ensure all the appropriate staff have access to use OxCORT. It is therefore suggested that you start by exporting the account information from the previous year and amending the data appropriately before importing the amended data for the new academic year.

⚠️ Any students omitted from the file will still be linked to their current Organising and Personal Tutors.

ℹ️ If you only wish to add or change the Organising or Personal Tutors for one or two students, refer to the Point Edit Student Records section on page 13.

To export the current student records
1. Select Bulk create student records from the main menu.
2. The Bulk Student Record Creation screen will be displayed.
3. Click the Export current data button.
4. You will be given the option to save or open the file. Select the option to Save and store the file in an appropriate location with an appropriate name, for example “Exported Student Records for Academic Year 0809”.

To view the list of student records previously exported from OxCORT
1. Open Microsoft Excel.
2. Select File>Open and browse the file you have saved from the export.
3. You may see a **Date Watch** dialog box. If you do click the OK button.

4. The spreadsheet will open listing all the student records currently set up in OxCORT.

![Spreadsheet Image]

**Column A**
will contain all the usernames for the students. Each student will probably be listed twice, once to link them to their Organising Tutor/s and again to link to their Personal Tutor/s.

**Column B**
will contain the role type that the student is being linked to, either OT (Organising Tutor) or PT (Personal Tutor).

**Column C onwards**
will contain the username/s of the member/s of staff the student is linked to.

5. Before you start to edit the information it is advisable to save the spreadsheet under a new file name so that you will still have a copy of the export which is unchanged. To do this select **File>Save As** ensure the file type is set to CSV (comma delimited) and enter a new name for the file, for example “Student Records for Academic Year 0910 for Import”.

---

**To edit or create the list of student records**

1. If you are creating the list for the first time open Microsoft Excel and work in a new worksheet. If you are editing the exported file follow the instructions above.

2. Ensure Column A contains the usernames for every student in your College for whom you need to create or change a record. For each student create one row to link to their Organising Tutor/s and a second row to link to their Personal Tutor/s.

3. In column B (against each username) enter the two character code for the type of link you are creating:

   - **OT** = To map the student to their Organising Tutor/s
   - **PT** = To map the student to their Personal Tutor/s

4. In column C, enter the username of the Organising or Personal Tutor you wish to link to the student. If you wish to link more than one then enter the second username into column D etc.

5. Select **File>Save As**, ensure the file type is set to CSV (comma delimited) and enter a new name for the file (if necessary).
If you do not include a student in this file they will remain linked to their current Organising or Personal Tutor. If you only create one row for the student links then the remaining information will stay the same, for example if you only create an Organising Tutor row then the Personal Tutor link will remain the same.

To import the CSV file
1. If necessary, select **Bulk create student records** from the main menu.
2. The **Bulk Student Record Creation** screen will be displayed.

3. Click the **Browse** button.
4. The **File Upload** dialog box will open. Navigate to the file you have created and click once to select it, then click the **Open** button.
5. In OxCORT, click the **Import** button.
6. You will be taken to the **Bulk Import Student Record** confirmation screen.

7. Click the **Yes - Replace student records** button.
8. The data will load and a bar will show it’s progress. When the upload has successfully completed you will be returned to the main menu.
13. **Point Edit Student Records**

The **Point Edit Student Records** screen allows you to link students to their Organising and Personal Tutors one student at a time.

Only the Tutorial Office role can Point Edit Student Records in OxCORT.

The Point Edit Student Records facility allows you to create or edit a student record one student at a time. Therefore if you need to add or edit a number of student records you may prefer to use the **Bulk Create Student Records** menu option which will allow you to create, enable, disable and modify user accounts for your College by importing a CSV (comma delimited). See the Bulk Create Student Records section on page 9 for further information.

**To create or edit a student record**

1. Select [Point edit student records](#) from the main menu.
2. You will be taken to the **Student Record Creation and Editing** screen.

3. Enter the username of the student.

   If you do not know the username of the Student, click the **Search for people** button and follow the instructions on page 27.

4. Click the **Show** button.

   If you do not click the **Show** button then any current Organising or Personal Tutors linked to the student will be removed and replaced.

5. The usernames of any current Organising or Personal Tutors will be displayed in the relevant fields (if there are currently no Organising or Personal Tutors linked to the student then these fields will remain blank).

6. Remove any Organising or Personal Tutors who are no longer linked to the student by deleting their username from the relevant field.
7. Add any new Organising or Personal Tutors by typing their usernames into the relevant field, pressing the [Enter] key between each username.

   If you do not know the username of the Tutor, click the button and follow the instructions on page 27.

8. Once all the Organising and Personal Tutors are linked to the student, click the button.

9. The Save Student Record screen will appear. Check the information is correct and click the button.

10. You will be returned to the Edit Student Record screen.
14. **Arrange Tutorials**

The Arrange Tutorials function allows you to enter tutorial arrangements for students at your College. You would normally carry out this task at the start of each term. A blank tutorial report form will then be created in OxCORT for Tutors to complete during the term and submit (normally in 7th week).

The Arrange Tutorials function can be accessed by the following College roles:

- Tutorial Office
- Senior Tutors
- Organising Tutors

Course Directors can also arrange tutorials. Tutors may also create their own tutorial report forms.

To arrange tutorials

1. Select **Arrange tutorials** from the main menu.
2. You will be taken to the **Arrange Tutorials** screen.

3. Enter the username of the Tutor for who you wish to arrange tutorials.
4. Click the **Show** button.

If you do not know the username of the Tutor, click the button and follow the instructions on page 27.

5. The full name of the Tutor will display, along with reminder of how long they are authorised to use the Tutor role within OxCORT (see the Authorise Tutors section on page 1).
6. From the list of undergraduate students for your College (shown below the Tutor’s name), select the students for whom the Tutorials are being arranged by clicking in the field to the left of their name to place a tick.

7. When all the appropriate students have a tick next to their name, scroll to the bottom of the screen.

8. Ensure the correct Term and Year are displayed (use the drop down to select the correct Term and Year if necessary).

9. The Subject and Category of the Tutor will be displayed (as entered by the Tutor on their Payment Details screen). Change these if necessary.

10. Enter the topic of the tutorials into the Topic field, for example “Imperial Britain 1815-1982”. The topic can be amended by the Tutor later if necessary.

11. If you wish OxCORT to send an email to the Tutor to let them know you have arranged their Tutorials on OxCORT, leave the tick in the field. (If you do not wish to send an email, untick this field).

12. Click the button.

13. You will be taken to the Create Reports – Confirmation screen.

14. Check that the details show are correct and click the button.
If you did not choose to send an email to the Tutor you have now finished the **Arrange Tutorials** process.

**Emailing the Tutor using OxCORT**

1. If you chose to send the Tutor an email, you will be taken to the **Send Emails** screen.

   ![Send emails](image)

2. Use the fields at the top of the screen to select recipients of the email.
3. You may edit the subject and the main text of the email if you wish.
4. Click the **Send email** button to have OxCORT send the email on your behalf.

   It will appear to the recipient of the email as though the email has been sent from your email address, see the Change Your Email Address section on page 22 for further details.

**Emailing the Tutor using your own email client**

1. If you chose to send the Tutor an email on the **Arrange Tutorials** screen, you will be taken to the **Send Emails** screen.
2. If you would prefer to use your own email client (rather than have OxCORT send the email on your behalf), scroll to the bottom of the **Send Emails** screen. There you will find a section entitled **Email Addresses**, this section contains the email addresses of all people associated with the report.
Email Addresses

Below is a complete list of the email addresses of the Tutor, Organising Tutors, Personal Tutors and student associated with the reports you have selected. If your email client is configured, you can click on a heading to compose an email to one of these groups of people. Alternatively, you can copy the addresses and paste them into your email client or into a file.

- **Tutors**: Harry Austey <harry@email.com>
- **Colleges**: North office <tutorials@north.ox.ac.uk>
- **Organising Tutors**:
  - Students: James Crazier <james@email.com>, Joseph Kampa <joseph@email.com>, Samuel Dasha <samuel@email.com>

Each email link is shown in blue with an underline e.g. [Tutors]. To the right of this the email address of the person/people is shown.

3. Click the appropriate link, and a new email will open in your email client, with the address of the recipient show in the To: field.

4. Copy and paste any further recipients from OxCORT to your email client and compose and send the email in the usual way.
15. **View Tutorial Arrangements**

The **View Tutorial Arrangements** screen allows you to view which Organising and Personal Tutors have been assigned to a student. It also allows you to see if a report has been created between a Tutor and the student and the topic of this report. The list may be filtered using the parameters provided at the top of the page.

**To view tutorial arrangements**

1. From the main menu, select **View tutorial arrangements** and the **Tutorial Arrangements** screen will be displayed. From the Tutorial Arrangements screen you may view the entire list, which is displayed below the filter options box or use the filter options to narrow the list.

![Tutorial Arrangements Screen](image)

2. To filter the list, choose one or a combination of the filter options provided which include, Programme of Study, Subject, Year of Study, Organising/Personal Tutor, and/or Student and click **View Tutorial Arrangements**.

In the example below we are searching for Tutorial Arrangements where an Organising Tutor has not been assigned:

![Filter Options](image)

*Note, The Programme of Study field requires the programme code, which can be typed directly into the field or use the **Search for PoS** option to find the code by searching for the programme name.*
3. The Tutorial Arrangements list is sorted into the following order:
   Term....................................Future through to previous
   Programme of Study....................Alphabetical
   Year of Study............................Starting with year 1
   Student.................................Alphabetical by surname

4. Under each student name will be listed:
   Any Organising Tutors assigned to that student
   Any Personal Tutors assigned to that student
   If any Tutorial reports have been created, the Topic and Tutor will display (if these are shown in grey, the report has a status of Not Edited)

5. Clicking on the student’s name will take you to the Search and Select screen with a list of reports relating to the student displayed.

6. Previous terms will display with students who have unsubmitted reports created about them. This is to allow you clearly identify any reports which have not yet been submitted.
16. **View Or Process Tutorial Reports**

The **View or Process Tutorial Reports** screen allows you to search for, select and perform various functions on both Tutorial and Revision Class reports.

From this screen you can select reports to:

- View
- Edit
- Print
- Delete
- Email those connected with the report
- Export data
- Approve or refuse for payment
- Release to students
- Return to the Tutor for correction
- Undo a payment decision made in error (either approve or refuse)
- Mark as processed for payment
- Set and clear academic and administrative markers (dots)

**To search for reports**

1. Select [View or process tutorial reports] from the main menu.
2. The **Report Search and Selection** screen will display.
3. Complete the search fields as appropriate (see below).
4. Click the [Search for Reports] button.
5. A list of matching reports will show in the Report Summaries area of the screen.

If you have performed a previous search, click the [Reset search criteria] button first to clear previous search options.

Search fields

The People section of the search allows you to search for the following:

<table>
<thead>
<tr>
<th>People</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Student</td>
<td>username</td>
</tr>
<tr>
<td>Tutor</td>
<td>username</td>
</tr>
<tr>
<td>Organising Tutor or Personal Tutor</td>
<td>username</td>
</tr>
</tbody>
</table>

Student – To find reports for a particular student, enter the Surname of the student in the first field or enter their username in the Username field.

Tutor – To find reports written by particular Tutor, enter the Surname of the Tutor in the first field or enter their username in the Username field.

Organising Tutor or Personal Tutor – To find reports with a particular Organising or Personal Tutor, select the type (Organising or Personal) from the drop down on the left and the name of the Tutor from the drop down on the right.

The Subject section of the search allows you to search for the following:

<table>
<thead>
<tr>
<th>Subject</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Programme of Study</td>
<td></td>
</tr>
<tr>
<td>Subject</td>
<td></td>
</tr>
<tr>
<td>Topic</td>
<td></td>
</tr>
<tr>
<td>Year of Study</td>
<td></td>
</tr>
</tbody>
</table>

Programme of Study – To search for reports relating to students studying a particular Programme of Study either enter the relevant Programme of Study Code into the field or click the Search for Code button to search for programme codes by name.

Subject – select from the drop down a Subject to search for.

Topic – To search for reports relating to a particular topic enter one or all the words from the topic into this field. If you do not know the exact wording of the topic then only enter one word from the topic (as soon as more than one word is entered into this field OxCORT assumes you only want to find reports which exactly match this wording).
Year of Study – To find reports relating to students in a particular year of study, select the relevant year from the drop down.

The Report Data section of the search allows you to search for the following:

Report Type – To find only Tutorial or only Revision Class reports select the relevant report type from this drop down.

Term – This field will default to the current term and year, to change to a different term or year or to retrieve reports from any term or year, select the relevant option from the drop downs.

Estimate of Term’s Work – To retrieve only those Tutorial reports which have been marked with a particular estimate of the term’s work, select the relevant mark from the drop down. This option is not available when searching for Revision Class reports.

Senior Tutor Flag – To retrieve those reports which have been flagged for the attention of the Senior Tutor, tick this field.

Missed Tutorials – To retrieve those reports where a figure has been enter to indicate the student missed some of the Tutorials during the term, tick this field.

Collections – To retrieve reports where the Collection marks are at a particular status, select the relevant option from the drop down field. You can select from the following options: No Collections Marked, Collection Marks Not Yet Known, Collection Marks Known But Not Final, Collection Marks Finalised.

Payment Method – Allows you to search for reports where the Tutor has selected a particular Payment Method.

Tutor Category – Allows you to search based on the category of the tutor, for example Tutorial Fellow, Professor, or Reader.

XRNLI – Each report has a report number which begins XRNLI, followed by the year, followed by the unique number. If you know the XRNLI number for the report you wish to retrieve entering it here will return an exact match. The number must be entered in the following format: XRNLI-yyyy-num> where yyyy enter the year, where num enter the number. You must include the – markers as shown.
The **Report State** section of the search allows you to search for the following:

![Report State](image)

**State** – To retrieve reports which have reached a particular status select the relevant option from the drop down. You can also search on status using the **Report Count** shown above the main menu.

**Student Access** – To search for only reports which have or have not been released to the student, select the relevant option from the drop down.

**Submitted Date** – To search for reports submitted between two particular dates, enter the dates in these fields. *You may need to change the Term search fields to Any Term and Any Year if the term shown does not match the dates you have entered.*

**College Flag** – To search for reports where the College flag has been set or cleared, select the appropriate option from the drop down.

**Academic Flag** – To search for reports where the academic flag has been set or cleared, select the appropriate option from the drop down.

### To view or edit a report

You may only view and edit submitted reports.

1. Select [View or process tutorial reports](#) from the main menu.
2. The **Report Search and Selection** screen will display.
3. Search for the reports as described in the **Search for Reports** section above.
4. Scroll down to the **Report Summaries** section of the screen to see the search results.

![Report Summaries](image)

You can sort the search results by clicking on the column headings, for example to sort the results by **Report Type**, click the **ReportType** column heading.
5. To open an individual report click on the name of the student. 

or

To open multiple reports, tick the field to the left of the student name on all the reports you wish to open and click the View or print button in the Actions section at the bottom of the screen.

6. The Report Viewing and Processing screen will be displayed.

7. Edit the reports as required. You will be able to edit the payment information (on the left side of the screen). The academic report information (on the right of the screen) will be protected so that you cannot change any of the information.

   For Revision Class reports please note that you will only be able to edit the Payment Method and College. The group size, hours or payment rate information is generated by the information entered in the setup screens, therefore if it is incorrect, the reports will need to be deleted and the Tutor will need to re-create the reports from the revision class setup screens.

8. Scroll to the bottom of the screen and click the Save Changes button.

   If you exit the screen without clicking the Save Changes button any changes you have made will be lost.

9. The confirmation screen will be displayed.
10. Check that the details are correct and click the 

button.

11. You will be returned to the Report Search and Select screen.

Deleting a report

You may only delete reports which have not yet been submitted for payment by the Tutor. If a report has already been submitted, you will need to return the report to the Tutor, this will change the status of the report from Submitted to Created allowing you to then delete the report.

1. Select View or process tutorial reports from the main menu.
2. The Report Search and Selection screen will display.
3. Search for the reports as described in the Search for Reports section above.
4. Tick the field to the left of the student name on all the reports you wish to delete and click the button in the Actions section at the bottom of the screen.
5. The confirmation screen will be displayed.

6. Click the button

7. You will be returned to the Report Search and Selection screen.

The action of deleting a report is irreversible.

You can also delete a report whilst viewing it by ticking the field, then scrolling to the bottom of the screen and clicking the button.
To display reports as a PDF file for printing

To make reports easier to print you have the option to display them as a PDF file.

1. Select **View or process tutorial reports** from the main menu.
2. The **Report Search and Selection** screen will display.
3. Search for the reports as described in the **Search for Reports** section above.
4. Tick the field to the left of the student name on all the reports you wish to display as a PDF file and click the **Display PDF** button in the **Actions** section at the bottom of the screen.
5. A new window will open with the report displayed as a PDF file. From here you can print the file, by selecting **File > Print**.

6. When you have finished, close the new window containing the PDF file.
7. You will be returned to OxCORT.

To send an email using OxCORT

You can send an email to people associated with a report using either OxCORT’s built in email facility or your own email client. The following instructions relate to sending an email using the OxCORT facility.

1. Select **View or process tutorial reports** from the main menu.
2. The **Report Search and Selection** screen will display.
3. Search for the reports as described in the **Search for Reports** section above.

4. Tick the field to the left of the student name on all the reports that contain the people you wish to email and click the **Email** button in the **Actions** section at the bottom of the screen.

5. You will be taken to the email screen.

6. Use the fields at the top of the screen to select recipients of the email, for example to email the student/s of the report/s you selected, place a tick in the **To**: field under **Students**.

7. Enter the subject and the main text of the email.

8. Click the **Send email** button to have OxCORT send the email on your behalf.

   ![Send email screenshot]

   It will appear to the recipient of the email as though the email has been sent from your email address, see the **Change Your Email Address** section on page 22 for further details.

**To send an email using your own email client**

You can send an email to people associated with a report using either OxCORT’s built in email facility or your own email client (for example Microsoft Outlook). The following instructions relate to sending an email using your own email client.

1. Follow the instructions numbered 1 through to 5 in the section above entitled **To send an email using OxCORT**.

2. At the bottom of the Email screen you will see a section titled **Email Addresses**.

   ![Email Addresses screenshot]

   Each email link is shown in blue with an underline e.g. **Tutors**. To the right of this the email address of the person/people is shown.
3. Click the appropriate link, and a new email will open in your email client, with the address of the recipient show in the To: field. For example, if you clicked on the Students link in the picture above, you would see the email addresses for Edward Andover and Joshua Abthorpe in the To: field.

4. Copy and paste the email address of any further recipients from OxCORT to your email client and compose and send the email in the usual way.

You can also email from a report whilst viewing it by clicking on any of the information in the header that is shown in blue with an underline.

To export data from reports

You can export data from selected reports to a .csv file.

1. Select View or process tutorial reports from the main menu.
2. The Report Search and Selection screen will display.
3. Search for the reports as described in the Search for Reports section above.
4. Tick the field to the left of the student name on all the reports that contain data you wish to export and click the Export data button in the Actions section at the bottom of the screen.
5. You will be taken to the Export Report Data screen.
6. Tick the fields to indicate the data that you would like to include in the export.

7. Click the *Export selected fields* button.

8. The *File Download* dialog box will appear, click the option to *Save* the file.

9. The *File Save* dialog box will open. Browse to the location where you would like to save the file and enter your preferred file name and save the file.

10. The file can now be opened using Microsoft Excel and the data manipulated as required.

**To approve reports for payment**

You can mark submitted reports as approved for payment, this will change the status of the report from *Submitted* to *Approved*.

Other roles that can mark reports as approved are:

- Organising Tutor or Personal Tutor
- Senior Tutor

1. Select [View or process tutorial reports] from the main menu.
To refuse reports for payment

You can mark submitted reports as refused for payment, this will change the status of the report from Submitted to Refused.

Other roles that can mark reports as refused are:
- Organising Tutor or Personal Tutor
- Senior Tutor

Only refuse a report for payment if you have no other option, reports that have been incorrectly completed should be returned to the Tutor for correction. A refused report cannot be edited and a Tutor will need to create the report again from scratch.

1. Select View or process tutorial reports from the main menu.
2. The Report Search and Selection screen will display.
3. Search for the reports as described in the Search for Reports section above.
4. Tick the field to the left of the student name on all the reports that you wish to refuse for payment and click the Refuse report button in the Actions section at the bottom of the screen.
5. The Confirmation screen will display.
6. Click the [Yes - Make changes] button.
7. You will be returned to the **Search and Select** screen.

![Warning]

You can also refuse a report whilst viewing it by clicking on the [No approval decision] drop down and selecting **Refuse Report** you must then scroll to the bottom of the screen and click the [Save Changes] button.
To delete a refused report

Refused reports may be deleted by first reversing the refused state and then returning the report to the Tutor to be deleted.

1. Select [View or process tutorial reports] from the main menu.
2. The Report Search and Selection screen will display.
3. Search for the reports as described in the Search for Reports section above.
4. Click on the relevant report to open it, the state of the report must be Refused.

<table>
<thead>
<tr>
<th>Student</th>
<th>Term</th>
<th>Subject</th>
<th>Report Type</th>
<th>View</th>
<th>Term</th>
<th>Time</th>
<th>Submitted</th>
</tr>
</thead>
</table>

5. At the bottom of the report, tick the box labelled 'Decision should be undone' and save the report.

6. On the confirmation screen, click 'Yes - Save changes'.
7. The status of the report will now have changed from 'refused' to 'submitted'.
8. The report can now be returned to the tutor, as described in the 'To return a report to the tutor for correction' section below, which will change the status of the report to 'created' after which it can be deleted, as described in the section Deleting a Report above.
View Or Process Tutorial Reports

To release a report to the student

Once a report has been submitted, you can release the report for the student to read online. Every student has automatic access to OxCORT but they can only see the report header until the report is released.

⚠️ The decision to release a report to a student is irreversible.

Other roles that can release the report to the student are:
- Organising Tutor
- Senior Tutor

1. Select [View or process tutorial reports] from the main menu.
2. The Report Search and Selection screen will display.
3. Search for the reports as described in the Search for Reports section above.
4. Tick the field to the left of the student name on all the reports that you wish to release to the students and click the Release to student button in the Actions section at the bottom of the screen.
5. The Confirmation screen will display.
6. Click the Yes - Make changes button.
7. You will be returned to the Search and Select screen.

You can also release a report whilst viewing it by clicking on the field to add a tick to the box you must then scroll to the bottom of the screen and click the Save Changes button.

To return a report to the Tutor for correction

If a submitted report is incorrect, you can return it to the Tutor for correction. This will change the status of the report from Submitted to Created.

Other roles that can return the report to the Tutor are:
- Organising Tutor
- Senior Tutor

1. Select [View or process tutorial reports] from the main menu.
2. The Report Search and Selection screen will display.

3. Search for the reports as described in the Search for Reports section above.

4. Tick the field to the left of the student name on all the reports that you wish to return to the Tutor and click the [Return to Tutor] button in the Actions section at the bottom of the screen.

5. The Confirmation screen will display.

<table>
<thead>
<tr>
<th>Return to Tutor</th>
</tr>
</thead>
<tbody>
<tr>
<td>You have selected 1 report to return to its Tutor.</td>
</tr>
<tr>
<td>The contents of reports that have been returned to the Tutor will no longer be visible to anyone else until the Tutor resubmits them.</td>
</tr>
<tr>
<td>Do you wish to proceed? If so, then save the changes. If not, click ‘No - Do NOT make changes’ in order to return to the report summary page.</td>
</tr>
<tr>
<td>Yes - Make changes</td>
</tr>
</tbody>
</table>

6. Click the [Yes - Make changes] button.

7. You will be returned to the Search and Select screen.

8. Send an email to the Tutor and (if appropriate) the Organising Tutor to notify them that the report has been returned and reasons behind this.

You can also return a report whilst viewing it by clicking on the field to add a tick to the box you must then scroll to the bottom of the screen and click the [Save changes] button.

If you use this method to return a report, you may use the section of the report to notify the Tutor of the reasons for returning the report. These comments will be deleted from the report when the Tutor resubmits the report. You will still need to send and email to the Tutor to notify them that the report has been returned.

To mark a report as processed for payment

Once a report has been marked as approved for payment, you will need to check that the report contains no payment errors and mark it as processed for payment.

You may prefer to do this using the Validate Tutor Teaching Data menu option, where the payment information is shown in a clear, easy to check style, however, if you are happy that there are no errors, you can instead mark the reports as processed for payment from the Search and Select screen.

This will change the status of the report from Approved to Processed.

No other roles can mark a report as processed for payment.

1. Select [View or process tutorial reports] from the main menu.
2. The Report Search and Selection screen will display.
3. Search for the reports as described in the **Search for Reports** section above.

4. Tick the field to the left of the student name on all the reports that you wish to mark as processed and click the **Mark as processed for payment** button in the **Actions** section at the bottom of the screen.

5. The Confirmation screen will display.

<table>
<thead>
<tr>
<th>Mark as processed for payment</th>
</tr>
</thead>
<tbody>
<tr>
<td>You have selected 1 report to process for payment.</td>
</tr>
<tr>
<td>This action is irreversible. Reports marked as processed for payment will appear in the downloadable payment file.</td>
</tr>
<tr>
<td>Do you wish to proceed? If so, then save the changes. If not, click ‘No - Do NOT make changes’ in order to return to the report summary page.</td>
</tr>
</tbody>
</table>

| Yes - Make changes | No - Do NOT make changes |

6. Click the **Yes - Make changes** button.

7. You will be returned to the **Search and Select** screen.

---

To undo a payment decision

If a payment decision (either approved, refused or processed) is incorrect, you can undo this decision. This will change the status of the report back to the previous status i.e. from **Approved / Refused** to **Submitted** and from **Processed** to **Approved**.

1. Select [View or process tutorial reports] from the main menu.
2. The **Report Search and Selection** screen will display.
3. Search for the reports as described in the **Search for Reports** section above.
4. Tick the field to the left of the student name on all the reports that have an incorrect payment decision and click the **Undo payment decision** button in the **Actions** section at the bottom of the screen.
5. The confirmation screen will display.

<table>
<thead>
<tr>
<th>Undo payment decision</th>
</tr>
</thead>
<tbody>
<tr>
<td>You have selected 1 report for which to undo payment decisions.</td>
</tr>
<tr>
<td>The Tutor will not be paid unless payment is subsequently approved.</td>
</tr>
<tr>
<td>Do you wish to proceed? If so, then save the changes. If not, click ‘No - Do NOT make changes’ in order to return to the report summary page.</td>
</tr>
</tbody>
</table>

| Yes - Make changes | No - Do NOT make changes |

6. Click the **Yes - Make changes** button.

7. You will be returned to the **Search and Select** screen.

8. If the original payment decision was made by an Organising or Senior Tutor, send them an email to notify them that the payment decision has been undone and explain the reasons behind this.
To mark a report with a College flag (red dot) or an academic flag (blue dot)

At any point you can mark a report with a College flag. This will place a red dot on to the report, which will be viewable by other Tutorial Office users in your College.

This process of marking the reports can be used for any purpose that suits your College. For example, you may wish to mark all the reports that have been printed with a College flag.

No other roles can mark a report with a College flag or see that a College flag has been added.

You may also mark the report with an Academic flag. This will place a blue dot on the report, which will be viewable by other Tutorial Office users and Senior Tutors. Academic flags are normally added by Senior Tutors to mark reports for any purpose that suits their needs.

It is possible to set both a red and a blue dot to a report at the same time.

1. Select View or process tutorial reports from the main menu.
2. The Report Search and Selection screen will display.
3. Search for the reports as described in the Search for Reports section above.
4. Tick the field to the left of the student name on all the reports that you wish to mark and click the [Set red dot] button or [Set blue dot] (as appropriate) in the Actions section at the bottom of the screen.
5. The Confirmation screen will display.

You wish to set the red dot on 1 report

Do you wish to proceed? If so, then save the changes. If not, click 'No: Do NOT make changes' in order to return to the report summary page.

[Yes: Make changes] [No: Do NOT make changes]

Note: If you chose to set a blue dot the wording of this screen would reflect this.

6. Click the [Yes: Make changes] button.
7. You will be returned to the Search and Select screen and a red (or blue) dot will display next to the report status.
8. When viewing the report the College flag field will show a tick.

You can also mark a report with a College flag whilst viewing it by clicking on the [ ] (to set a red dot) or [ ] (to set a blue dot) field to add a
To remove a College flag (red dot) or an academic flag (blue dot) from a report

1. Select [View or process tutorial reports] from the main menu.
2. The Report Search and Selection screen will display.
3. Search for the reports as described in the Search for Reports section above.
4. Tick the field to the left of the student name on all the reports that you wish to un-mark and click the Clear red dot or Clear blue dot button (as appropriate) in the Actions section at the bottom of the screen.
5. The Confirmation screen will display.

<table>
<thead>
<tr>
<th>Clear red dot</th>
</tr>
</thead>
<tbody>
<tr>
<td>You wish to clear the red dot on 1 report.</td>
</tr>
<tr>
<td>Do you wish to proceed? If so, then save the changes, if not, click 'No - Do NOT make changes' in order to return to the report summary page.</td>
</tr>
</tbody>
</table>

Click the Yes - Make changes button.

6. Click the Yes - Make changes button.
7. You will be returned to the Search and Select screen and the red (or blue) dot will no longer display next to the report status.
8. When viewing the report the College or academic (as appropriate) flag field will no longer show a tick.

You can also remove a College flag from a report whilst viewing it by clicking on the [ ] (to remove a red dot) or [ ] (to remove a blue dot) field to remove the tick from the box, you must then scroll to the bottom of the screen and click the Save Changes button.
17. **Manage Stint Data**

This screen allows you to enter against each Tutor who has a stint at your College the core stint hours and any adjustments/remissions for each term.

Core stint hours will normally be entered at the start of each academic year or at the start of a new Tutor’s post.

Adjustments / remissions will normally be entered on a termly basis as and when necessary.

![Tutors must have recorded that they have an appointment at your College in their Change Payment Details screen.](image)

**To enter core stint data**

2. Click the [Manage Stint Data] link on the main menu.

3. The **Manage Tutor Stint** screen will be displayed.

4. Enter the Tutor’s username and click the **Show** button.

   ![If you do not know the username of the Tutor, click the **Search for people** button and follow the instructions on page 27.](image)

5. The Tutor’s full name and subject will be displayed.

6. If you have previously entered stint data for this Tutor, select the year that you wish to enter the stint information for and click the **Add** button.

   ![You may display but not edit information from the previous year.](image)

7. Enter the number of hours per week the Tutor is required to teach as part of their stint into the **Stint (hrs/week)** field against each term.
You may copy information from the previous year by clicking the button. You can then edit the information shown and continue with step 13 below.

8. For each term, select whether the stint report should show stint hours submitted on the reports as **Contact** (Clock hours), **Weighted** or **Contact and Weighted** hours from the **Reporting Basis** drop down.

9. Click the **Save Tutor Data** button.

10. The Confirmation screen will be displayed.

11. Click the **Save data** button.

12. You will be returned to the main menu.

**To enter stint adjustments**

13. Click the **Manage Stint Date** link on the main menu.

14. The **Manage Tutor Stint** screen will be displayed.

15. Enter the Tutor's username and click the **Search** button.

> If you do not know the username of the Tutor, click the button and follow the instructions on page 27.

16. The Tutor's full name and subject will be displayed.

17. Select the year that you wish to enter the adjustment information for and click the **Reload** button.

18. **To enter additional hours**, select **Addition** from the **Adjustment type** drop down, then enter the number of additional hours per week into the **Contact hrs/week** field. If required you can also enter a reason or description of the amendment into the **Description** field.

19. **To enter remission**, select **Remission** from the **Adjustment type** drop down, then enter the number of remission hours per week into the **Contact hrs/week** field. If required you can also enter a reason or description of the amendment into the **Description** field.

20. In the case of **full remission**, select **Full remission** from the **Adjustment type** drop down. The **Contact hrs/week** field will grey out and the remission amount will be set to the same as the core hours for that term. If required you can also enter a reason or description of the amendment into the **Description** field.

21. When you have entered the adjustments, click the **Save Tutor Data** button.

22. The confirmation screen will display.
23. Click the **YES : Save data** button.

24. You will be returned to the **Manage Tutor Stint** screen.
Validate Tutor Teaching Data
18. Validate Tutor Teaching Data

This screen allows you to retrieve and view summary information relating to any approved reports for which Tutorial teaching needs to be paid for by your College or charged to a Tutor’s stint.

If the Summary Data appears to be amiss in any way you will be able to drill down to the individual OxCORT reports to make any corrections as necessary.

To view teaching hours
1. Click the Validate Tutor Teaching Data link on the main menu.
2. The Validate Teaching Hours screen will be displayed.
3. Select the Term and Year that you wish to validate from the fields.
4. Click the button to retrieve the data for the selected term and year.
5. Click the Select Tutor drop down and select the Tutor.

- The list of Tutors will include those who have either selected your College as their own or who have submitted reports about your students during the selected term.
6. Click the button.
7. Data relating to the selected Tutor will be displayed in two sections:

  **Internal Tuition / Out Tuition** – This data relates to reports submitted about your students regardless of whether the Tutor is affiliated with you College.

  **External Tuition** – This data relates to reports submitted by a Tutor affiliated with your College where the student is from a different College.
To view and edit Internal Tuition / Out Tuition reports

1. Follow the steps 1 – 7 in the section entitled To view teaching hours above.
2. Click the student’s name.
3. You will be taken to the Teaching Hours Details screen.
4. A list of relevant reports is displayed

<table>
<thead>
<tr>
<th>Report Ref (XRNLI)</th>
<th>Subject</th>
<th>Tutor Category</th>
<th>Report Type</th>
<th>Topic Title</th>
<th>Collection Marking</th>
<th>Group Size</th>
<th>Hours tuition</th>
<th>Payment Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>XRNLI:2008-1017</td>
<td>English</td>
<td>Supplementary Lecturer</td>
<td>Tutorial</td>
<td>Validate Teaching</td>
<td>1</td>
<td>2</td>
<td>8</td>
<td>Standard rate</td>
</tr>
</tbody>
</table>

5. To view or edit the report, click the XRNLI number.
7. View and edit the report in the usual way (see the To view or edit a report section on page 24).
8. Click the Save Changes button.
9. The confirmation screen will display.
10. Click the Yes-Save-changes button.
11. To return to the Teaching Hours Details screen.

This screen will still show the original report data and will not reflect the changes you have just made.

12. Click the Cancel button to return to the Validate Teaching Hours screen.

This screen will still show the original report data and will not reflect the changes you have just made. Click the Retrace button next to the Tutor’s name to see the changes.

To view a list of External Tuition reports

1. Follow the steps 1 – 6 about in the section entitled To view teaching hours
2. The bottom part of the screen will show teaching undertaken by a Tutor who has stated they are affiliated with your College but have undertaken teaching of students from other Colleges.
3. To view the list of related reports, click the College name.
4. The list of reports is displayed.

You cannot view External Tuition reports because only the users from the Student’s College may do so.

To mark the reports as “Processed for Payment”
1. Follow the steps 1 – 7 in the section entitled To view teaching hours above.
2. Check and edit the reports as necessary (see section To view and edit Internal Tuition / Out Tuition reports above).
3. Click the button.
4. You will be taken to the Confirmation screen.
5. Check the details are correct and click the

6. You will be returned to the Validate Teaching Hours screen.
Calculate Payments And Teaching Hours
19. **Calculate Payments And Teaching Hours**

This screen allows you to calculate payments due from your College to other Colleges, Departments and Tutors; manually enter payment amounts where a Tutor has selected a payment rate of Other and calculate the number of hours teaching that a Tutor who has a stint has completed.

**To enter non-standard payment amounts**

1. Click the [Calculate Payments & Teaching Hours](#) link on the main menu.

2. The **Payments and Teaching Hours Options** screen will display.

3. Click the [Enter non-standard payment amounts](#) link.

4. The **Enter non-standard payment amounts** screen will be displayed.

5. Select the Term and Year for which you wish to enter the non-standard payment amounts.

6. Click the [Select Tutor](#) drop-down, a list of Tutors who have submitted reports with a payment rate of Other, for the selected term, will be displayed.

7. A list of the reports for the selected term that have been submitted by the selected Tutor with a payment rate of Other will be displayed.
8. For each report, enter the total payment either by entering a percentage of the Standard rate or by entering an ad-hoc amount:

9. To enter a percentage of the Standard rate: Enter the percentage into the Percentage of standard rate field. For example, if the Tutor is to be paid 125% of the standard rate, enter 125 into the Percentage of standard rate field. Click the Calculate button. The calculated amount will be displayed in the Total tuition payment for this Report field.

10. To enter an ad-hoc amount: Type the amount due directly into the Total tuition payment for this Report field.

The Recalculate button will show the totals for amounts you have entered so far. The Reset button clears all fields and allows you to re-enter the information.

11. When you have entered all the payment information, click the Save payment data button.

12. The Confirmation screen will be displayed

13. Click the YES - create payment button.

14. You will be returned to the Enter non-standard amounts screen and the status of these reports will change from Processed to Completed.
To preview payments details
This screen allows you to create a preview of the payment calculations prior to the update taking place.

1. Click the Calculate Payments & Teaching Hours link on the main menu.
2. The Payments and Teaching Hours Options screen will display.
3. Click the Payment preview link.
4. The Payment preview screen will be displayed.

5. Choose the Term and Year from the available drop down boxes.
6. Click the Generate payment preview button to generate the preview file.
7. The Payment preview file is created as a CSV file.

The file is saved as a .csv (comma separated value) file. You can open the file in Excel to manipulate the data. When you open the file in Excel you may see a Date Watch dialog box, if you do click the OK button.

To calculate payments and teaching hours
This screen will change the status of all Processed reports to Completed with the exception of those with a payment rate of Other (see previous section).

8. Click the Calculate Payments & Teaching Hours link on the main menu.
9. The Payments and Teaching Hours Options screen will display.
10. Click the Calculate payments and teaching hours link
11. The Calculate payments and teaching hours screen will be displayed.
12. Select the **Term** and **Year**.

13. Click the **Calculate payments & teaching hours** button.

14. The Confirmation screen will be displayed

15. Click the **YES - calculate payments and teaching hours** button.

16. You will be returned to the main menu.

```
All Processed reports (except those with a payment rate of Other) will now have a status of Completed.
```
20. **Manage Tutor Payment Data**

This screen allows you to download (into a .csv file) data from reports with a status of Completed.

This file can then be sent to your accounts / payroll department for payments to be made to Tutors, Departments and other Colleges.

**To include reports which have a status of Approved**

1. Click the [Manage Tutor payment data] link on the main menu.
2. The **Management of Tutor Payment Data** screen will display.

3. To include any reports which have a status of **Approved** in the payment file, click the [Mark all approved, unpaid reports as processed for payment] button.
4. All the reports that had a status of **Approved** will change to have a status of **Processed**.
5. Follow the instructions below in the section **To include any reports which have a status of Processed**.

**To include reports which have a status of Processed**

1. Click the [Manage Tutor payment data] link on the main menu.
2. The **Management of Tutor Payment Data** screen will display.
3. If you have any reports that have a status of **Processed** which you wish to include in the payment file, click the [Calculate payments and teaching hours] button.
4. The **Payments and Teaching Hours Options** screen will open. See the Calculate Payments And Teaching Hours section on page 48 for further details.
5. Once all the reports you wish to include have a status of **Completed** follow the instructions below in the section **To export a payment file**.

**To export a payment file**

1. Click the [Manage Tutor payment data] link on the main menu.
2. The **Management of Tutor Payment Data** screen will display.
3. Enter the date range for the reports you wish to include in the file into the fields, these are the dates on which the report status changed to Completed.

4. To include reports where the Tutor is to be paid directly, click the field to add a tick.

5. To include reports where the Tutor’s College is to be paid, click the field to add a tick.

6. To include reports where the Tutor’s department is to be paid, click the field to add a tick.

7. To include reports where the Tutor is to be paid by ULNTF, click the field to add a tick.

8. To include reports where the Tutor does not require payment, click the field to add a tick.

9. Click the appropriate download button:
   - click this button to export data for each individual report.
   - click this button to export data which shows the total amount each Tutor is owed.

10. The File Download dialog box will open, click the option to Save the data.

11. Browse to the location where you would like to save the file, enter a name for the file and click the Save button.

   The file is saved as a .csv (comma separated value) file. You can open the file in Excel to manipulate the data. When you open the file in Excel you may see a Date Watch dialog box, if you do click the button.
21. Reports

This screen allows you to view payment related reports as follows:

- Payment-Related Operational Reports
  - Tuition Payments Summary
  - Payment Slips
- Stint-Related Operational Reports
  - Stint Report Summary
  - Individual Tutor Stint Report

To view payment related operational reports
1. Click the Reports link on the main menu.
2. The Reports Menu screen will display.
3. Click the Tuition Payments link.
4. The Tuition Payment Reports screen will display.
5. If necessary, select the Term and Year of the reports you wish to include.
6. Enter the dates between which the reports you wish to include were marked as Completed.
7. Select the appropriate button as follows:
   - Select this option to display a summary of payments made on the screen.
Manage Tutor Payment Data

Select this option to display the payment slips on the screen.

<table>
<thead>
<tr>
<th>North, Oxford</th>
<th>23-Oct-2009</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tilson payments for Michaelmas 2009</td>
<td></td>
</tr>
<tr>
<td>Arlington, Jack</td>
<td></td>
</tr>
<tr>
<td>North</td>
<td></td>
</tr>
<tr>
<td>Term: Mathematics</td>
<td></td>
</tr>
<tr>
<td>Bank name: Oxford Bank</td>
<td></td>
</tr>
<tr>
<td>Sort Code: 123456</td>
<td></td>
</tr>
<tr>
<td>Acc number: 12345678</td>
<td></td>
</tr>
<tr>
<td>Home Address: 27 North Street, Oxford</td>
<td></td>
</tr>
<tr>
<td>OX1 1DX</td>
<td></td>
</tr>
<tr>
<td>Summary of teaching hours</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>Group</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------</td>
</tr>
<tr>
<td>1.00</td>
<td>1</td>
</tr>
<tr>
<td>1.00</td>
<td>2</td>
</tr>
<tr>
<td>1.00</td>
<td>3</td>
</tr>
<tr>
<td>PAYE</td>
<td></td>
</tr>
<tr>
<td>Total:</td>
<td>E157.88</td>
</tr>
</tbody>
</table>

This summary gives the number of hours the tutor has spent teaching members of this college.

8. To print either of the above reports, select File > Print from the browser menu. If possible change the settings on the printer to print in landscape.

The look and feel of the printed documents will depend upon your browser settings:
To change the font select Tools > Options from the browser menu (Internet Explorer has a Fonts button on the General tab. Firefox has a font option on the Content tab).
To change the size of the text, select View > Text Size from the browser menu.

To view stint related operational reports
1. Click the Reports link on the main menu.
2. The Reports Menu screen will display.
3. Click the Stint Report link
4. The Stint Reporting screen will display.

5. If necessary, select the Term and Year of the reports you wish to include.
6. Enter the dates between which the reports you wish to include were marked as Completed.
7. Select from the Student Type drop down as follows:
   - Internal – Select this option to include only reports for Students from your College.
   - External – Select this option to include only reports for Students from other Colleges.
All – Select this option to include all reports for both internal and external students.

8. Select the appropriate button as follows:

- Select this option to display the stint information for each Tutor on the screen. You will see information for all Tutors who have stint in the selected term, but the report will only include teaching for reports marked as Completed between the dates you selected.

- Select this option to display the stint information one Tutor per sheet.

9. To print either of the above reports, select File > Print from the browser menu. If possible change the settings on the printer to print in landscape.

The look and feel of the printed documents will depend upon your browser settings:
To change the font select Tools > Options from the browser menu (Internet Explorer has a Fonts button on the General tab. Firefox has a font option on the Content tab).
To change the size of the text, select View > Text Size from the browser menu.
List Payments Due From Other Colleges

This screen allows you to view or download information relating to exchange teaching.

To view payments due from other Colleges on screen
1. Click the **List payments due from other colleges** link on the main menu.
2. The **Payments Due From Other Colleges** screen will open.

3. Enter the date parameters for the reports you wish to show in the **Show reports submitted on or after** and on or before **fields.** These are the dates on which the reports were submitted by the Tutor.
4. Select the Term and Year about which the reports were written in the **Show reports written about** fields.
5. Click the **Show inter-College teaching** button.
6. The inter-College teaching recorded on reports that match your search criteria will display on the screen.

<table>
<thead>
<tr>
<th>Bagnis, Ruby (sum2007)</th>
<th>XRNLI code: 2008-1971</th>
<th>Fee code: 05040</th>
<th>Submitted date: 26/10/2008</th>
<th>State: Approved</th>
<th>Group size: 1</th>
<th>Clock hours: 1.00</th>
<th>Payment rate: 4.00</th>
<th>Tuition &amp; Marking &amp; Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total for this Report:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.00</td>
<td>5.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total for this Tutor:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Moroz, Amy (sum2035)</td>
<td>XRNLI code: 2008-2046</td>
<td>Fee code: 05040</td>
<td>Submitted date: 03/11/2008</td>
<td>State: Submitted</td>
<td>Group size: 1</td>
<td>Clock hours: 1.00</td>
<td>Payment rate: 6.00</td>
<td>Tuition &amp; Marking &amp; Total</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total for this Report:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.00</td>
<td>6.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total for this Tutor:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total from East:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

7. The results are displayed in alphabetical order of College name. Each College is sub-divided into Tutors (in alphabetical order of surname), with the reports for each Tutor displayed beneath their name.

8. Any reports with a status of **Completed**, will show the amount for Marking, Tuition and the Total for both. A grand total for each Tutor and then each College will also be displayed. (This only includes reports with a status of Completed, any reports shown with any other status will not be included in any totals shown.

Any totals shown only include reports with a status of **Completed**, any reports shown with any other status will not be included in any totals shown.
To export payments due from other Colleges

1. Click the [List payments due from other colleges] link on the main menu.

2. The Payments Due From Other Colleges screen will open.

3. Enter the date parameters for the reports you wish to show in the Show reports submitted on or after [01/01/2023] and on or before [01/01/2023] fields. These are the dates on which the reports where submitted by the Tutor.

4. Select the Term and Year about which the reports were written in the Show reports written about [Term] and [Year] fields.

5. Click the [Export] button to export all the data broken down by report. Click the [Export totals] button to export the totals only, broken down by Tutor.

6. The File Download dialog box will open, click the option to Save the data.

7. Browse to the location where you would like to save the file, enter a name for the file and click the [Save] button.

The file is saved as a .csv (comma separated value) file. You can open the file in Excel to manipulate the data. When you open the file in Excel you may see a Date Watch dialog box, if you do click the [OK] button.
23. **View Tutorial Hours By Organising Tutor**

The **View Tutorial Hours by Organising Tutor** screen allows you to view how many tutorial hours a student has received per academic year based on reports that have a status of *Processed* or *Completed*. The students are displayed by Organising Tutor thereby allowing you to see the Total and Average number of tutorial hours for each Organising Tutor.

**To view tutorial hours by Organising Tutor**

1. Select [View tutorial hours by Organising Tutor] from the main menu.
2. The **Tutorial Hours by Organising Tutor** screen will be displayed.

![Image of tutorial hours for students](image.png)

3. Data for the current academic year will be displayed.

> Only those reports which have a status of *Processed* or *Completed* will be included in the data shown.

4. Under each Organising Tutor will be displayed the names of the students who have reports with the appropriate status, with the number of hours tutorials that student has received so far this academic year displayed to the right of their name.

![Image of tutorial hours for students](image.png)

5. At the end of each Organising Tutor list will be shown the total number of hours tutorials for all the students and the average number of hours per student.

> If a student has multiple Organising Tutors, their tutorial hours will be repeated under each of their Organising Tutors.
To view tutorial hours for a previous academic year

1. Select [View tutorial hours by Organising Tutor] from the main menu.

2. The **Tutorial Hours by Organising Tutor** screen will be displayed.

3. Data for the current academic year will be displayed.

4. Select the required academic year from the drop down.

5. Click the **Calculate and display** button.

6. The data for the selected year will be displayed.
24. **View Management Information**

This screen allows you to view and download statistical data on reports in OxCORT. The Senior Tutor and OxCORT Management roles can also view management information. The OxCORT Management Committee role is the only role in OxCORT that can view College names against this information. As a Tutorial Office user you will be able to compare your statistics against other (anonymous) Colleges.

> When viewing statistical information, OxCORT will only include those reports which have a status of Completed.

**To view statistical information**

1. Click the [Management Information] link on the main menu.
2. You will be taken to the Management Information screen.
3. Click the [View statistical information] link.
4. You will be taken to the **Statistical Reporting** screen.

5. Select which statistics you would like to report on by choosing from the **Show** drop down list.
6. Select whether to show results for all or selected Colleges, from the drop down.

7. To search based on the Programme of Study, enter the PoS code(s) into box provided. Alternatively, use the button to find programmes by name.

8. Finally, select the year that you would like the statistics to be taken from.

9. Next you need to decide how you would like the results to be broken down; select the relevant options from the Breakdown display section.

<table>
<thead>
<tr>
<th>Breakdown display</th>
<th>No Breakdown</th>
<th>By row</th>
<th>By column</th>
</tr>
</thead>
<tbody>
<tr>
<td>College</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subject</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programme of Study</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Term</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Year of Study</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tutor category</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group size</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Statistical analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

10. When you have finished selecting the options you require, click the button to display the results on screen, or the button to save the results in a CSV (comma delimited) file to be opened and manipulated in Excel.

If you wish to export the results, first click the Calculate and Display button to check the results are those you expected. When you are happy with the content and display of the results, click the Calculate and Export option.

To view the Benchmark report

This report shows the number of students in selected programmes of study, their contact hours, average hours, and the percentage of their contact hours contributed by each category of tutor. After selecting the required academic year and programmes of study, you can display the report to the screen (‘Calculate and Display’) or exported to an Excel spreadsheet (‘Calculate and Export’). A summary of all selected programmes is shown at the bottom of report.
1. Click the [Management Information] link on the main menu.
2. You will be taken to the Management Information screen.
3. Click the [Benchmark report - student hours by tutor category] link.
4. You will be taken to the [Statistics Benchmark Report] screen.

5. Select the academic year for which you wish to produce the report by selecting it from the drop-down.
6. Select the Programmes of Study you wish to report on by either entering the codes directly into the Programme of Study field or, to search for the Programme of Study by name, click the [Search for PoS] button (to include all Programmes of Study, leave this field blank).

   ![Image of academic year and programme of study selection]

   If you choose to run the report for all programmes of study at once, it could take several minutes to finish.

7. To display the results on screen, click the [Calculate and Display] button.
8. To export the results to a spreadsheet, click the [Calculate and Export] button.
9. The following information for your college is presented alongside the equivalent University-wide information:

   **Number of students taught**: the number of students enrolled on the selected programmes of study for whom OxCORT reports have been completed

   **Contact hours**: the total number of contact hours received by your students from each category of tutor, broken down by Programme of Study. This is obtained by adding the figures on all completed OxCORT reports, including Revision Class reports, for the selected academic year.

   **Average hours**: the number of hours received by the average student in your college from each category of tutor. This is obtained by dividing contact hours by the number of students enrolled in the selected programme of study.

   **%**: the contact hours contributed by each tutor category expressed as a percentage of the total contact across all tutor categories for each programme of study.

   Only reports with the status 'Completed' will be included in the tally.
25. Log Out Of OxCORT

It is important that you log out of OxCORT and Web Auth correctly, particularly if using a shared or public computer. Failure to log out of WebAuth correctly means that another person using the computer after you could potentially access the system.

⚠️ After 1 hour of inactivity, you will be automatically logged out of OxCORT.

To log out of OxCORT

1. Click **Log Out** link, shown in the top right of each screen or the **Log out of OxCORT** option on the main menu.
2. You will see the **User Logged Out** screen.

   Thank you for using OxCORT. You are now logged out.
   You may also want to log out of WebAuth.
   Click here to log back in to OxCORT.

3. Unless you wish to use any of the other Single Sign On applications (e.g. Weblearn), you must click the **log out of WebAuth** link.
4. You will be taken to the **University of Oxford Single Sign-On Logout** screen.

5. Close your web browser (select **File>Exit** from the browser menu). Until you close your web browser you will not be fully logged out.
26. Data Protection Act

Guidelines for Oxford Colleges Online Reporting for Tutorials (OxCORT)

As you are probably aware, most of the data held on the Oxford Colleges Online Reporting for Tutorials (OxCORT) is covered by the Data Protection Act. More detailed information is available at the following web addresses:

University Policy on Data Protection:
http://www.admin.ox.ac.uk/councilsec/dp/policy.shtml

Regulations Relating to the use of Information Technology Facilities:
http://www.admin.ox.ac.uk/statutes/regulations/196-052.shtml

OSS Data Management Policy:
http://www.admin.ox.ac.uk/studentsystems/oxonly/techiez/s-ossusers.shtml

Further to that, here are some simple guidelines to help you to keep within the bounds of the Act.

1. Familiarise yourself with the University's policy on Data Protection by reading the information available at the web addresses above.
2. Ensure that you are familiar, and comply with the university's duties relating to the use of IT facilities (see link at the top of the page).
3. Adopt secure passwords, keep them secure and change them regularly.
4. Do not reveal your password to another person.
5. Do not reveal any personal data to unauthorised third parties.
6. Keep hard copies of personal data in locked drawers/filing cabinets and dispose of them securely by shredding or putting them in a confidential waste bin.
7. Keep electronic copies of personal data (reports/spreadsheets etc) in a secure directory or password protect them if held elsewhere.
8. Do not download from OxCORT onto a home computer or laptop unless as specifically authorised by your Information Custodian.
9. Log out of OxCORT or lock your workstation if leaving your desk, or have a password protected screensaver set to activate within ten minutes or less.
10. Never leave screens showing personal data as the top screen when you leave your desk at all, even if it's just for the minute it takes you to get a printout off the printer.
11. Do not leave printouts of personal data on the printer.
12. Destroy both electronic and hard copies of personal data when they are no longer needed.

It is recommended that you audit your files at least twice a year and dispose of any material that is no longer needed.

If you have any questions about the Data Protection Act and how it affects your work, further information can be obtained from the University's Data Protection Officer:

Website: http://www.admin.ox.ac.uk/councilsec/dp
Email: data.protection@admin.ox.ac.uk
27. Document Information

This document is subject to change – amendments will be apparent from a change in version numbering.

<table>
<thead>
<tr>
<th>Revision Date</th>
<th>Version Number</th>
<th>Summary of Changes</th>
<th>Changed By</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
28. Further Help & Information

OxCORT Support Centre:
Contact OxCORT Support if you are a member of staff and require assistance.
Tel: (2)84848, Fax: (2)84880
Email: OxCORT@admin.ox.ac.uk
Hours: Mon - Fri, 08:30-17:00

WebAuth:
Requesting a WebAuth account
http://www.ict.ox.ac.uk/oxford/username/
To get your password reset
https://webauth.ox.ac.uk/reset_password
Virtual Card for Non-University Staff
http://www.admin.ox.ac.uk/card/oxonly/virtual_access/

Student Information and Advisory Service:
Contact SIAS if you are a student and require assistance.
Examination Schools, 75-81 High Street, Oxford, OX1 4BG
Tel: (2)86223
Hours: Mon - Fri, 09:30-16:30

Business Services and Projects Website:
For further information about BSP
http://www.admin.ox.ac.uk/bsp

Student Systems Website:
For further information about OSS
http://www.admin.ox.ac.uk/bsp/studsys-support-centre

BSP Training:
For further information about the training courses we offer.
http://www.admin.ox.ac.uk/bsp/studsys-support-centre/osstraining
Email: studentsystems.training@admin.ox.ac.uk

Student Systems Information Custodians:
For further information about Information Custodians.
http://www.admin.ox.ac.uk/bsp/studsys-support-centre/gettingaccess/access-requests/

Regulations Relating to the use of Information Technology Facilities:
http://www.admin.ox.ac.uk/statutes/regulations/196-052.shtml

University Terms Glossary:
For a list of Oxford University terminology and their meanings.
http://www.ox.ac.uk/about_the_university/introducing_oxford/oxford_glossary/

University Policy on Data Protection:
http://www.admin.ox.ac.uk/dataprotection

University’s Data Protection Officer:
http://www.admin.ox.ac.uk/dataprotection/oxonly/contacts